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Purpose of This Document 

This document contains OpenVMS-specific usage information about running NetBeans™. It is 
intended for a general user audience. Installation information, including system requirements 
and prerequisites, are contained in the: 

    NETBEANS36_INSTALLATION_GUIDE_OPENVMS.TXT|PS|PDF|HTML 

What’s New Information  

NetBeans Version 3.6 is a new feature release and upgrades NetBeans Version 3.5.1, which was 
primarily a performance enhancements release.  For complete new feature information about 
NetBeans Version 3.6, see: 
 

http://www.netbeans.org/community/releases/36/Whats_New.html  

 
NetBeans Version 3.6 for OpenVMS contains a new plug-in module, the OpenVMS FORTRAN 
Compiler Support Module.  This module, along with the OpenVMS C/C++ Compiler Support 
Module, the OpenVMS DCL Command Support Module, the OpenVMS EDT Editor Keybindings 
Module, and the OpenVMS CMS Support Module, is available from within NetBeans in the Update 
Center on the Tools menu. 
 
NetBeans Version 3.6 assumes that you have Version 1.4.2-x of the Java SDK for OpenVMS 
installed. (Java 5.0 is not supported.)  If the Java SDK for OpenVMS is not installed in its default 
location, or if you want to use a version of the Java 2 SDK earlier than 1.4.2, define 
NETBEANS$JDK_HOME so NetBeans can find the Java directory.   
 
For a GUI-based development environment on OpenVMS, consider using Distributed NetBeans, 
which provides a cost-effective and flexible development environment solution. More information 
about Distributed NetBeans can be found at: 

 
 http://www.hp.com/products/openvms/distributednetbeans/ 
 
For a list of the known problems in Version 3.6, visit: 
 

http://www.netbeans.org/community/releases/36/relnotes.html#KnownProblems 
 
For an overview of NetBeans for OpenVMS features, visit: 
 

http://h71000.www7.hp.com/openvms/products/ips/netbeans/overview.html  

Conventions 

 
The following conventions are used in this document: 

    UPPERCASE/lowercase Java™ is a case-sensitive language and NetBeans requires 
                             an ODS-5 disk.  Commands are mixed case as required.                   
 
    $    Indicates the DCL prompt. This prompt may be different 
                            on your system. 
 
    [optional-name]  Square brackets indicate that the enclosed item is 
          optional (unless within a file specification). 
 
    <variable-name>         Angled brackets indicate a placeholder for a command-line option 
          a system-specific name, or some other variable. 
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1. RUNNING NETBEANS FOR OPENVMS 
 

Importing from Previous Versions 

 
After installing NetBeans 3.6 for OpenVMS you can automatically import settings and project 
information created by NetBeans 3.3.1 or higher for OpenVMS. You must do this the first time you 
start up NetBeans.  
 
Importing settings from NetBeans 3.2 and 3.21 for OpenVMS is not supported. In order to 
preserve settings and project information, Version 3.2x users should first upgrade to Version 3.3.1 
or higher.   
 
You can download Version 3.3.1 or higher for OpenVMS from the NetBeans release archive. 
 

http://www.netbeans.org/downloads/ide/archive/release_archive.html 

 
See Section 3 for details of the import process. 

Before You Run NetBeans 

There are several requirements for this application to work properly: 

• Your NetBeans user directory must be on an ODS-5 disk. This directory is set the first time 
you start NetBeans. By default, the directory is automatically created by NetBeans as a 
subdirectory under your SYS$LOGIN directory. 
 
Important If your SYS$LOGIN directory is on an ODS-2 device, you must specify an ODS-
5 device and directory as your NetBeans user directory when starting NetBeans. 

• By default, NetBeans 3.6 uses Java 1.4.2 of the JVM. If you have an earlier version of 
Java installed on your system, you must set the NETBEANS$JDK_HOME logical to point to 
that JVM. 

The logical name NETBEANS$JDK_HOME must be defined with a string that points to the 
directory where the SDK is installed. The Launcher uses the FastVM for the main process.  
You can override this using the logical name NETBEANS$CLASSIC_VM. Setting the value 
of this logical to 1 causes the Classic VM to be used instead of the FastVM. 
 

• User process quotas must be sufficient, as recommended in the NetBeans for OpenVMS 
Installation Guide: Installation Prerequisites. In particular, the SYSGEN value for 
CHANNELCNT should be at least 2000. 
 

• The SDK logical names and settings for NetBeans are configured when you run the 
RUNIDEOPENVMS command procedure. Making changes to these settings can cause 
unexpected behavior in NetBeans. 
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Starting NetBeans 

 
To start the NetBeans IDE on an OpenVMS system, execute the RUNIDEOPENVMS.COM 
command procedure or a NetBeans symbol that runs this command file: 
 

$ @<device>:[<directory>.NETBEANS36.BIN]RUNIDEOPENVMS.COM [<startup args>] 

where: 

<device> and <directory> are the device and directory where NetBeans is installed. 

or 

You can define a NetBeans symbol, typically in SYLOGIN.COM, such as: 

$ NETBEANS :== @ODS5$DISK:[NETBEANS36.BIN]RUNIDEOPENVMS.COM 

Optional Startup Arguments 
     The following startup arguments may be used: 
 

$ NetBeans [<User_dir|-help>] [<Java_switches>] 
[<NetBeans_switches>] 

where: 

[<User_dir|-help>] can be: 
 

An optional OpenVMS directory specification that will be used as the home 
directory for NetBeans user-specific files. If not specified, the subdirectory 
[.NETBEANS.3_6] from your SYS$LOGIN directory is used. If the directory does 
not exist, it is automatically created. 
 
Important Your user directory must reside on an ODS-5 device. 

or 

          The -help switch to see command-line help about the IDE launcher. 

[<Java switches>] is an optional list of switches that you want to pass to the Java 
Virtual Machine. You can also specify NetBeans properties here. For example: 

-Dnetbeans.windows=sdi 

If the list contains more than one value or has lowercase characters that must be 
preserved, you should enclose the list within double quotes (""). If the value contains a 
directory specification, it must be in UNIX-style format. For example:  

"/dev/dir0/dir1/.../file.ext" 

See the Java SDK Release Notes for more information about Java switches. 
                     

          http://h18012.www1.hp.com/java/documentation/ 
 

 [<NetBeans switches>] is a list of switches that you want to pass to the NetBeans 
IDE. 

If the list contains more than one value or has lowercase characters that must be 
preserved, you should enclose the list within double quotes (""). If the value 
contains a directory specification, it must be in UNIX-style format. For example: 
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"/dev/dir0/dir1/.../file.ext" 

A common setting is the standard font size to use within the IDE. For example: 

 "-fontsize 12" 

 
Initial default web browser setup 
When starting NetBeans for the first time, the default browser to be used must be 
changed from External Browser to the Swing HTML Browser.  To do this, start    
NetBeans and go to the Tools menu.  Select Startup Wizard, and then at the web browser combo 
box, select Swing HTML Browser. Then click Finish. 
 
Using a configuration file at startup 
You can also pass startup parameters to the IDE Launcher using the 
<IDE_HOME>/bin/ideopenvms.cfg file. The Launcher tries to read this file before it starts 
parsing the command-line options. Only one option can be specified on each line. 
 
The following options (including the "-") can be specified in the configuration file: 
 

-J<jvm_flag> 
Pass the specified flag directly to the JVM. 

 
-fontsize <value>  
Sets the font size, expressed in points, in the IDE's user interface. If this option is not 
used, the font size is 11 points. 

 
-locale language[:country[:variant]] 
Use the specified locale. 
 

 For example, an ideopenvms.cfg could contain the following:  
 

! Lines that do not start with "–" are considered comments 
! 
! First a Java switch - this will display garbage collection  
! information 
! 
-Jverbose:gc 
! 
! Now a NetBeans switch - this will set the font size to a more  
! readable 14 points 
! 
-fontsize 14 

Logical Name Definitions 
You can define one or both of the following logical names prior to starting 
RUNIDEOPENVMS.COM in order to override the default values: 
 
NETBEANS$JDK_HOME   Allows you to specify the location of the 

version of Java that you want to use. If defined, the value of this 
name must be an OpenVMS directory specification that points to 
the installed location of the Java 2 SDK version you want to use. 
 

Example: 
 
$ DEFINE NETBEANS$JDK_HOME SYS$COMMON:[JAVA$141] 
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NETBEANS$USER   Allows you to specify the user directory that 
will be used by the IDE. If defined, the value of this name must be 
an OpenVMS directory specification on an ODS-5 disk. The IDE 
will create the directory if it does not exist. 
 

Example: 
 

$ DEFINE NETBEANS$USER MYDISK$:[MYDIR.USER] 

How the NetBeans Launcher Uses the OpenVMS JVM 
For performance reasons, NetBeans for OpenVMS uses the FastVM when running the IDE. 
However, the FastVM does not support the Java debug architecture, JPDA. In order to compile 
and debug Java programs, the spawned subprocesses created during compilation and debugging 
must use the Classic VM.  
 
In order to implement this behavior, NetBeans for OpenVMS defines logical names for the JVM 
(JAVA$JVM_G_SHR and JAVA$JVM_SHR) to point to the FastVM shareable images, while 
confining these logical name definitions to the main process. 
 
If you would like NetBeans to use the Classic VM for all operations, you can define the logical 
NETBEANS$CLASSIC_VM as follows: 
 
 $ Define NETBEANS$CLASSIC_VM 1 
 

Startup Examples 
 

$ @RUNIDEOPENVMS USER$:[MYACCOUNT.NETBEANS] 

Starts NetBeans with the specified user directory. If the required directory structure and files 
do not exist, the NetBeans IDE will create them automatically. 
 

$ NetBeans "" "" "-fontsize 14" 

Starts NetBeans using a font size of 14. Note that null arguments ("") are required as 
placeholders and that the quotes around the specified argument are optional in this case. 

NetBeans Launcher Now Uses User Mode Logicals 
The NetBeans Launcher loads logical names into the Process table in User mode each time 
NetBeans starts. These user-mode logicals are removed when image rundown occurs. When 
NetBeans is running, all applications started from NetBeans will use subprocesses with the same 
logicals as NetBeans itself. 
 
When developing Java or C/C++ applications with NetBeans, you may find different behavior in 
development mode than you will when your applications are running in their own process space. 
 
These DECC-feature logical names are enabled: 
 

DECC$ARGV_PARSE_STYLE 
DECC$EFS_CASE_PRESERVE 
DECC$POSIX_SEEK_STREAM_FILE 
DECC$EFS_CHARSET 
DECC$EFS_NO_DOTS_IN_DIRNAME 
DECC$ENABLE_GETENV_CACHE 
DECC$ENABLE_TO_VMS_LOGNAME_CACHE 
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DECC$FILE_PERMISSION_UNIX 
DECC$FIXED_LENGTH_SEEK_TO_EOF 
DECC$RENAME_NO_INHERIT 

 
These Java$ logical names are set by the Launcher: 
 

JAVA$CACHING_DIRECTORY 
JAVA$CACHING_INTERVAL is set to 240           
JAVA$CREATE_DIR_WITH_OWNER_DELETE 
JAVA$CREATE_ONE_VERSION 
JAVA$DAEMONIZE_MAIN_THREAD 
JAVA$DELETE_ALL_VERSIONS 
JAVA$DISABLE_MULTIDOT_DIRECTORY_STAT  
JAVA$FILE_OPEN_MODE is set to 3 
JAVA$FORK_PIPE_STYLE is set to 2 or 1 
JAVA$FSYNC_INTERVAL is set to 3 
JAVA$KEYBOARD_TYPE_DEC (optional, if NETBEANS$KEYBOARD_TYPE_DEC is 
also set) 
JAVA$READDIR_CASE_DISABLE 
JAVA$RENAME_ALL_VERSIONS 
JAVA$TIMED_READ_USE_QIO          
 

The Java$Filename_Controls logical is set to: 
 

JAVA$M_UNIX_AND_VMS 

Default User Directory 

In NetBeans 3.6, the default user directory created the first time you run NetBeans is 
[.NetBeans.3_6] in your SYS$LOGIN directory. This is the location for all project property files 
and does not have any influence on the location of your source files. You can run NetBeans using 
other user directories by specifying the directory as the first startup argument (P1) with the 
RUNIDEOPENVMS command procedure. For example: 
 
$ @ODS5$DISK:[NETBEANS36.BIN]RUNIDEOPENVMS "EFS$:[JOEUSER.MYNBUSER36]" 

 
(You can mount whatever directories you choose in the NetBeans Explorer and create new 
projects using the Project Manager in the IDE.) 

Default MDI Window Mode 

The NetBeans IDE is now MDI (multiple document interface) by default. That means all secondary 
windows are constrained by the main application window. You can change to SDI (single 
document interface) - making each secondary window independent of the main application window 
- by using the Setup Wizard from the IDE’s Tools menu. 
 
Note When in MDI mode, secondary windows can still become detached from the main application 
window. This is by design. To reattach a floating window, use the Attach MDI Frame command 
from the IDE’s Window menu. 

Using Javadoc 

NetBeans supports the Javadoc standard for Java documentation.  You can view and generate 
Javadoc documentation from within the IDE.  

Mounting Javadocs 
From the Tools menu, choose Javadoc Manager. In the Javadoc Manager you can 
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mount and unmount directories, archives, and web-based sources. Note that the Hidden 
property must be set to True for a Javadoc node to be visible in Filesystems. 

For example, you can download the Java 2 SDK documentation archive file to your 
OpenVMS system and mount the .zip file.   

Java 2 SDK documentation is available from: 
 http://java.sun.com/j2se/1.3/docs.html 

Context-sensitive lookups 
Any Javadoc archives are automatically included when you do context-sensitive lookups. 
To do a context-sensitive lookup: Press Shift+F1 when the edit cursor is on a package or 
function name.   

More information about using and generating Javadoc is available within the 
NetBeans IDE from the Core IDE Help: 
Working with Java Source: Working with Javadoc Documentation: Mounting a 
Javadoc Filesystem 

Using JavaHelp 

JavaHelp is available in the NetBeans IDE from the Help menu and by clicking Help buttons or the 
F1 key on various IDE objects, such as node icons and property sheets.  
 
JavaHelp for OpenVMS users is installed with each of the available NetBeans modules for 
OpenVMS. This help is fully integrated with the standard NetBeans JavaHelp and may be opened 
from the Help menu. (The HelpSet option in the Help menu lists installed module help files.) 
 
JavaHelp texts may be copied and pasted into an external text editor or printed. URL links 
provided in JavaHelp that are not hypertext can be copied and pasted into a browser's address 
field. 

Downloading and Installing NetBeans Plug-in Modules 

The NetBeans IDE features an Update Center wizard (Tools menu), which provides a convenient 
way to update the IDE with new functional units called modules.  

Through the wizard, NetBeans for OpenVMS provides access to both the NetBeans Update 
Center and the NetBeans for OpenVMS Update Center. The OpenVMS Update Center contains 
modules that are designed to enhance the usability and productivity of NetBeans for OpenVMS 
customers. 

Note If you are behind a firewall, you will need to set up the Proxy Configuration.  

General Instructions 

1. Open the NetBeans Update Center wizard (choose Update Center from the Tools menu).  

2. With the Check the Web... option selected, choose the NetBeans for OpenVMS Update 
Center and click Next. 

-or- 

Choose the Install Manually Downloaded Modules option if applicable and click Next. 

3. Follow the instructions on the wizard for completing installation. 

4. After clicking Finish, if you are prompted to restart NetBeans, you must choose Restart 
the IDE to complete installation of the module. 
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Single-User Versus Multi-User Installation 
When you install new plug-in modules using the Update Center wizard, you have the choice to 
install them for individual use or for systemwide use.   

Single-user mode 
This is the default choice. The module files are placed in your NetBeans user directory 
(such as NBUSER36). This means that only you have access to the module. 

Multi-user mode 
If you want to do a systemwide installation, select the Global? option on the View 
Certificates and Install Modules page of the wizard. The module files are placed in the 
NetBeans installation directories, and all users of NetBeans will have the module loaded at 
startup.  

Notes for multi-user installation 

• Your process must have write access to the directories in which NetBeans is 
installed.  

• No other users should be running NetBeans while you are doing the update.  
• You may need to change the protection of installed modules so that others can 

access the files.  

Local (Offline) Installation 
You can install NetBeans modules (.nbm file) from locations other than the Internet-based Update 
Centers. For example, you may want to install a previously downloaded .NBM file on a local drive. 
In this case, you still use the Update Center wizard, but you choose the Install Manually 
Downloaded Modules option. 
 

Important  You must change the record format of the downloaded .nbm file to 
STREAM_LF before installing it. You can use this command: 
 

$ SET FILE/ATTRIBUTE=(RFM:STMLF,RAT:CR) <modname>.nbm 
 
To download modules for offline installation, see the Modules Download Page 
 
http://h71000.www7.hp.com/openvms/products/ips/netbeans/nbmdownload.html 
 
 
Note to OpenVMS eBusiness CD Users 
The NetBeans plug-in modules are included on the OpenVMS eBusiness CD. Before you 
install them, copy the modules to your ODS-5 disk and rename them using lowercase 
letters, as follows.  (The .nbm files on the eBusiness CD are in STREAM_LF format, and 
the format does not change when you copy the files to your system.) 
 
edtkeypad.nbm 
openvmscmsprofile.nbm                
openvmscppsupport.nbm 
openvmsdclsupport.nbm                 
openvmsfortransupport.nbm 

 
 

Performance Tuning NetBeans on OpenVMS 

There are defaults chosen in the NetBeans Launcher for the initial stack size, initial heap size, and 
maximum heap size.  These values were selected based on tests that simulated an average 
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workload. If your NetBeans process is running out of heap or stack space, you may need to start 
NetBeans with a larger value for the stack size or maximum heap size.  
 
This is an example of setting the maximum heap size to 350MB and the stack size to 2MB. 
 
 NetBeans "" "-Xmx350m –Xss2m" 
  
For more information about various performance switches for the SDK on OpenVMS see the Java 
SDK Release Notes. 
(http://h18012.www1.hp.com/java/documentation/) 

Optimizing the Look and Feel of NetBeans for OpenVMS 

The look and feel of NetBeans for OpenVMS is highly dependent on being set up with the right 
fonts and point sizes. 

Fonts and eXcursion  
If you are an eXcursion user, to ensure that the appearance of the NetBeans user interface is 
optimal, the following font sets should be installed in eXcursion: 

Speedo 
Type 1 
Misc 
100dpi 
75dpi 

Check their presence by opening the eXcursion Control Panel and selecting the Fonts tab. 

On your eXcursion system 
If one or more font sets is not present, you can reinstall eXcursion (and choose the option to 
install all fonts) or you can do the following: 

1. Locate the directory location of the font sets that come with the eXcursion kit. 

2. Open the eXcursion Control Panel and select the Fonts tab. 

3. Specify the full path of each missing font set in the New Font Path Elements group box 
and click Add.  

4. Once you have all five sets installed and activated, restart the eXcursion server. 

On your OpenVMS system 
Like the previous instructions, this is only applicable to eXcursion users. Do the following: 

1. Copy the eXcursion font properties file to your LOGIN directory. 

The standard location for this file is 
SYS$COMMON:[JAVA$142.JRE.LIB]FONT_PROPERTIES.EXCURSION 

2. Copy it to SYS$LOGIN:FONT.PROPERTIES 

See the Java SDK Release Notes for important information about Java, eXcursion, and 
fonts. (http://h18012.www1.hp.com/java/documentation/) 

Console users 
Do not use the eXcursion FONT.PROPERTIES file as described above. 
 
Font size selection 
Readability of fonts in the NetBeans IDE, whether you are using a console or eXcursion, may be improved 
by setting a default font size of your choosing. Do so by using the NetBeans startup switch "-fontsize 
<n>".  For example: 

 
$ @ODS5$DISK:[NETBEANS36.BIN]RUNIDEOPENVMS "" "" "-fontsize 12" 
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Uninstalling NetBeans 

 
To uninstall NetBeans, use the PCSI PRODUCT REMOVE command. 
 
If you execute a PRODUCT REMOVE command for NetBeans 3.5.1, you may see the following 
errors:  
 

Portion done: 0%...10%...20% 
%PCSI-E-FILNOTPUR, error deleting 
EFS$:[000000.][NETBEANS3.5_1.tomcat404.webapps.to 
mcat-docs.appdev]web^.xml.txt;1 
-SYSTEM-W-BADFILENAME, bad file name syntax 
%PCSI-E-FILNOTPUR, error deleting 
EFS$:[000000.][NETBEANS3.5_1.tomcat404.webapps.to 
mcat-docs.appdev]build^.xml.txt;1 
-SYSTEM-W-BADFILENAME, bad file name syntax 
.  .  .  .  .  .  .  .  .  .  .  .  .  .  
-SYSTEM-W-BADFILENAME, bad file name syntax 
Portion done: 90% 
%PCSI-E-FILNOTPUR, error deleting 
EFS$:[000000.][NETBEANS3.5_1.bin.fastjavac]fastja 
vac^.sun.intel;1 
-SYSTEM-W-BADFILENAME, bad file name syntax 
%PCSI-E-FILNOTPUR, error deleting 
EFS$:[000000.][NETBEANS3.5_1.bin]^.runide_default 
s.sh;1 
-SYSTEM-W-BADFILENAME, bad file name syntax 
Portion done: 100% 
 
This indicates that the product is marked as "removed", but all of the associated files have 
not been deleted. 
 
Workaround 
Delete the NetBeans 3.5.1 installation directory yourself. You will first need to delete all 
the files (and any remaining subdirectories and their files) in the installation directory. 
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2. RESTRICTIONS AND LIMITATIONS 
 

Initial Default Web Browser Setup 

 When starting NetBeans for the first time, the default browser to be used must be 
 changed from External Browser to the Swing HTML Browser.  To do this, start    
 NetBeans and go to the Tools menu.  Select Startup Wizard, and then at the  
 web Browser combo box, select Swing HTML Browser.  Then click Finish. 

Debugging JSPs in NetBeans for OpenVMS 

Debugging JSPs (Java Server Pages) from within NetBeans for OpenVMS is not  
supported in Version 3.6. This is a known problem in Version 3.6, and will be fixed 
in a future release. 

The NetBeans User Directory Must Be on an ODS-5 Disk 

 
See Section 1: Before You Run NetBeans. 

NetBeans for Java Source and Package Files on an ODS-2 Disk 

 
Java source files residing on an ODS-2 disk can be used from within NetBeans, but the class 
and package names in the files must be entirely in lower case. The files on the ODS-2 disk will 
have uppercase names, but the Java Virtual Machine will translate the names to lower case. 
When NetBeans attempts to match a filename to a classname, only class and package names 
that are completely lowercase will match. 

Importing Projects from Other IDEs 

 
Importing a project from another IDE (for example, Microsoft Visual J++, JBuilder, Visual Cafe, 
and NetBeans/Forte for Java) will not work. 

Manually Convert Source Files to STREAM_LF Format 

 
NetBeans can create improper line breaks in source files that have a record format other than 
STREAM_LF. You may need to manually convert files to STREAM_LF before you access 
them within the NetBeans IDE. 

File Specification Syntax 

 
All file specifications you use within the NetBeans IDE must use standard UNIX syntax. This 
applies to the NetBeans Open File dialog box and Filesystems window. 

Removing Old Java Symbols and Logicals 

 
When you run a particular version of Java, various version-specific symbols and logical names 
are defined. Before you can use a different Java version, you must execute the appropriate 
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DCL command procedure to remove these old symbol and logical name definitions. For Java 
2 SDK 1.3.1-6, run the following command: 

$ @SYS$COMMON:[JAVA$131.COM]JAVA$<xxx>_CANCEL_SETUP.COM  

    where <xxx> is the Java version (for example, 118 or 122) you are removing. 
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3. IMPORTING FROM PREVIOUS VERSIONS 
 

NetBeans 3.6 can import projects and settings created with NetBeans 3.3.1 (and higher) 
for OpenVMS versions. This update process is fully automated using the Settings Import 
Wizard. 

During the import process, you will be prompted for the location of your existing user 
directory (such as .NBUSER33). This directory is not affected in any way by the import 
process. 

Important You must import your project when prompted to by the wizard - you cannot 
import at a later time. 

Using the Settings Import Wizard 

After installing NetBeans 3.6, the first time you start the IDE, the Settings Import Wizard appears 
(before the Setup Wizard). Three simple steps are involved: 

Page 1 Do you need to import settings? 

Choose Yes if you are upgrading from 3.3.1 or higher and want to import your 
settings and your projects. 

Page 2 Locate previous IDE? 

Browse for or type your existing user directory (for example, 
/device/user/nbuser33). Click Next to start the import process. 

Page 3 Import settings 

Wait for the import process to complete and click Finish (which initiates the 
Setup Wizard). 

After the import process and completion of any remaining setup, NetBeans 3.6 will open with the 
projects imported from the previous version of NetBeans. If the import is successful, you should 
see that your user environment and settings for the previous version of NetBeans have been 
transferred to NetBeans 3.6. 

Usage Notes 

The following additional information explains a little more about the import and update process and 
addresses a few issues related to it. 
 
Backup Directory 
Before the import operation starts up, NetBeans 3.6 creates a backup directory named 
.USERDIR_BACKUP under the same parent directory as the new 3.6 user directory. This directory 
is only used if the import process fails for some reason, in which case a default 3.6 user directory 
will be restored. 
 
File Import Process 
Once the backup directory is created, NetBeans copies the files from the user directory of the 
previous version of NetBeans into the user directory of NetBeans 3.6 with the exception of 
userdir.cfg. It then updates the imported files under the NetBeans 3.6 user directory and continues 
to start up. 

If, for any reason, the copy operation fails, the NetBeans 3.6 user directory will be restored from 
the .USERDIR_BACKUP directory. NetBeans 3.6 will continue to start up without importing. 
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4. REPORTING AND RESOLVING PROBLEMS 
 
Support for NetBeans for OpenVMS is provided under existing OpenVMS service agreements 
through standard support channels. 
 
    http://www.hp.com/country/us/eng/contact_us.html 
 
As an open source application, NetBeans is also supported through peer-support channels. 
NetBeans.org is home to the NetBeans Open Source project and is the best resource for general 
support information and links to peer-support groups. 
 

To ask questions or give feedback 
Send your technical questions and feedback about NetBeans for OpenVMS directly to the 
engineering team at: 

 NetBeans@hp.com 

 

To participate in peer groups 
NetBeans.org provides a variety of mailing lists and newsgroups that can answer most 
user questions. 

http://www.netbeans.org/community 
 

To report bugs 
NetBeans.org provides a bug-entering system called IssueZilla, which you can use to 
enter and track issues. The submission form includes an operating system selection field 
that lists OpenVMS. 

http://www.netbeans.org/community 
 

General Comments and Feedback 
If you would like to provide comments or general feedback about the e-Business offerings for 
OpenVMS, please send mail to: 
 
        OpenVMS.eBusiness@hp.com  
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